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Mate preferences are important causes of sexual selection. They shape the
evolution of sexual ornaments and displays, sometimes maintaining genetic
diversity and sometimes promoting speciation. Mate preferences can be
challenging to study because they are expressed in animal brains and
because they are a function of the features of potential mates that are
encountered. Describing them requires taking this into account. We present
a method for describing and analysing mate preference functions, and intro-
duce a freely available computer program that implements the method. We
give an overview of how the program works, and we discuss how it can be
used to visualize and quantitatively analyse preference functions. In addi-
tion, we provide an informal review of different methods of testing mate
preferences, with recommendations for how best to set up experiments on
mate preferences. Although the program was written with mate preferences
in mind, it can be used to study any function-valued trait, and we hope
researchers will take advantage of it across a broad range of traits.
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Darwin (1871) identified a broadly fascinating topic of
modern biology when he pointed out the special nature
(and consequences) of mate preferences. Mate prefer-
ences are mental phenomena — representations of the
attractiveness of potential mates, expressed in animal
brains as the product of sensory and neural processing.
They are a kind of cognitive phenotype, and studying
them is at the forefront of the objective study of how
mental phenomena influence behaviour and decision-
making (Mendelson efal, 2016). Because mate
preferences influence mate choice decisions, they can
generate strong sexual selection (Darwin, 1871; West-
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& Seether, 1999; Andersson & Simmons, 2006; Cotton
et al.,, 2006; Prum, 2012). This places the study of mate
preferences at the intersection of behavioural ecology,
neuroscience and evolutionary biology.

Mate preferences are expressed as a function of the
features of potential mates that are encountered. In
other words, they are function-valued traits (Meyer &
Kirkpatrick, 2005; Stinchcombe et al., 2012). The func-
tion-valued nature of mate preferences means that
describing them requires assessment across a range of
display trait values. When an individual encounters a
potential mate, only a fraction of its mate preference is
expressed — the part that corresponds to the potential
mate’s trait values. Confronted with another potential
mate with different features, that same individual with
that same mate preference may respond differently.

Describing mate preferences brings insight into the
causes of selection and speciation, and into how organ-
isms perceive and process some of the most salient
aspects of their environments (Ritchie, 1996; Jennions &
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Petrie, 1997, Wagner, 1998; Widemo & Seether, 1999;
Andersson & Simmons, 2006; Chenoweth & Blows,
2006; Cotton et al., 2006; McPeek & Gavrilets, 2006;
Rodriguez et al, 2006, 2013a; Sullivan-Beckers &
Cocroft, 2010). When used to characterize populations
or species, descriptions of mate preferences offer a
straightforward framework to test hypotheses about the
action of sexual selection due to mate choice (Fig. 1).
Meanwhile, studying mate preferences at the level of
individuals can shed light on the developmental and
genetic underpinnings of preferences, which is key for
assessing the generality of theoretical models of sexual
selection and speciation (Jennions & Petrie, 1997, Mead
& Arnold, 2004; Kuijper et al., 2012; Roff & Fairbairn,
2014; Sharma et al., 2016).

Here, we present a simple method for describing
and analysing mate preference functions, and a com-
puter program that implements it. The method takes a
function-valued approach, viewing the entire prefer-
ence function as the trait of interest for an individual
(or population). It then extracts some measurements
(preference function traits) from the curve that
describe the preferred sexual display values and the
shape of the curve around those preferred values
(Fig. 1). These traits are key for testing hypotheses
about mate preferences as causes of sexual selection
(Rodriguez et al., 2006, 2013a). For example, peak pref-
erence indicates the display value that should have
peak fitness under sexual selection due to mate
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choice; other traits indicate the expected strength of
selection (Fig. 1) (see below). The traits are also useful
for describing components of variation in mate prefer-
ences such as repeatability, heritability and plasticity
(Fowler-Finn & Rodriguez, 2012a,b, 2013; Rebar &
Rodriguez, 2013, 2014; Rodriguez et al., 2013b.

Describing and analysing mate
preference functions

Consider an experiment that we might use to describe
mate preferences for one of our study animals, a spe-
cies of Enchenopa treehopper (Hemiptera: Membraci-
dae) (Fig. 2). Enchenopa females respond to male
advertisement signals that they find attractive with sig-
nals of their own, establishing a duet that continues
while the male searches for the female, until copula-
tion begins (Fig. 2a) (Cocroft et al., 2008). By playing
back a sample of male signals to a female and seeing
how she responds to each one, we describe her prefer-
ence across a range of male signal trait values. Such
playback experiments produce data sets with two basic
components: an independent variable encompassing
variation in a signal trait (in this example, dominant
frequency, or pitch) and a dependent variable reflect-
ing the female’s ranking of the attractiveness of the
stimuli (measured here as the number of responses
she emitted when presented with each male signal)
(Fig. 2b).
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Fig. 1 Mate preferences represent variation in the attractiveness of sexual displays and can take various forms. In each panel, curves depict
preferences, and the histograms correspond to the distribution of sexual display traits. (a) Mate preferences may have closed shapes,
meaning that peak display attractiveness is reached at some intermediate display trait value. There can be variation in peak preference
(black vs. grey curves). (b, ¢) Mate preferences may also have open-ended shapes. Here too, peak preference may vary; for example, the
grey curves would have peaks at the extreme value of the test range, whereas the black curves might have a peak part-way across their
plateaus. Mate preferences may also vary in the extent of the decrease in attractiveness as displays deviate from the peak preference (d, e,
f: black vs. grey curves). When contrasted against the distribution of sexual display traits (histograms), mate preferences constitute
hypotheses about the form of sexual selection. For example, in (a), the preference in black represents stabilizing selection, whereas the
preference in grey represents directional selection. Similarly, in (b) and (c), the preferences in black and grey represent varying levels of

directional selection.
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Data such as the above can be used to generate mate
preference functions. A variety of approaches have
been used for this purpose, but they all share the goal
of producing a function that describes variation in the
attractiveness of a sexual trait. One method is to use
sets of comparisons between paired stimuli, drawing a
line linking the attractiveness of each stimulus pair to
assemble an overall shape that is inspected visually
(e.g. Jang & Greenfield, 1996; Gerhardt et al., 2000;
Murphy & Gerhardt, 2000; Shaw, 2000; Shaw & Her-
lihy, 2000; Hobel & Gerhardt, 2003; Gerhardt, 2005a,
b). Another method is to assume given function shapes,
such as linear, quadratic, logistic or sigmoidal, and fit
such functions to the data (e.g. Endler & Houde, 1995;
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Fig. 2 Example of a mate preference function, from a study with
Enchenopa treehoppers (Hemiptera: Membracidae), which are
plant-feeding insects that communicate with plant-borne
vibrational signals (Cocroft & Rodriguez, 2005). (a) Spectrogram of
male and female Enchenopa duetting signals, including 0.25-s bar
for scale. Males travel in search of females, signalling when they
reach a new plant. A female that finds a male’s signals attractive
will engage in a duet with him until he locates her (Cocroft et al.,
2008). (b) Behaviour of an Enchenopa female interacting with
playback stimuli resembling male advertisement signals. The data
points indicate the duetting signals that the female produced when
presented with each stimulus, and the curve shows the cubic
spline generated from those data points (see text), which depicts
the female’s mate preference function. The preference function
peaks at a narrow range of stimulus frequencies and drops sharply
as stimuli deviate in either direction away from those preferred
frequencies. Note that, in any one encounter with a given male,
only a portion of this female’s preference function would be
expressed. Nevertheless, the entire function is the trait of interest.

Brooks & Endler, 2001; Burke & Murphy, 2007). Yet
another method is to use nonparametric analyses that
do not assume any given shape (e.g. Ritchie, 1996;
Jang & Greenfield, 1998; Brooks & Endler, 2001;
Ritchie ef al, 2001; Simmons et al, 2001; Reinhold
et al., 2002; Brooks et al., 2005; Rodriguez et al., 2006).
We value this variety of approaches, because it allows
researchers to adjust to the biology and behaviour of
their study organism (Reinhold & Schielzeth, 2015).
Indeed, researchers often combine some of the above
approaches within a single study. For example, linear
and quadratic terms are often used for significance test-
ing in combination with nonparametric regression for
visualization (see below).

Our method adopts the philosophy of making as few
assumptions as possible about the shape of mate pref-
erences, following Schluter (1988) and Brodie et al.
(1995). We use generalized additive models (GAMs) to
fit nonparametric curves — termed cubic splines — to
the raw response data (Wood, 2006). This allows the
shape of the mate preference to be determined primar-
ily by the pattern of responses across a range of stimuli
(Fig. 2b), rather than by an a priori expectation. As a
result, there are no real restrictions to the data that
can be analysed as long as it broadly follows the stim-
ulus-response structure that we outline here. We
favour this approach because we are interested in
exploring variation in mate preferences, and thus,
fewer shape assumptions afford greater potential for
discovery. Note that although our method avoids pre-
specifying linear or quadratic shapes, it can be used in
conjunction with analyses that do use those terms (see
below).

With cubic splines, the shape of mate preferences
depends in part on a smoothing parameter (Schluter,
1988; Wood, 2006). Less smoothing produces wobblier
functions that can detect more local peaks and troughs,
whereas more smoothing produces less wobbly func-
tions that highlight only the major peaks and troughs
(Fig. 3). Current statistical software automatically
chooses a smoothing parameter that optimizes the pre-
dictive power of the function for a given data set
(Schluter, 1988; Wood, 2006, 2011). The default in our
method is to smooth out functions that are very wob-
bly — to extract the underlying function from the
(sometimes noisy) raw behavioural data — but we allow
users to adjust smoothing values when necessary (see
below). With this default, we follow the rationale from
studies of the form of selection that the true function is
more likely to be smoother than very wobbly (Schluter,
1988). We consider that this rationale should fit mate
preferences well: being based on neural activity, mate
preference functions are likely to be relatively smooth,
continuous functions, rather than very wobbly or
jagged. Even preference functions with sharp transi-
tions (e.g. step functions with thresholds) are not likely
to have the many tiny peaks of a wobbly spline
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(Fig. 3a), and their analysis can benefit from visualizing
them as somewhat smooth functions.

Mate preference function traits

Once a function has been generated, our method uses
several metrics to describe a few key aspects of varia-
tion in mate preferences (Fig. 4).

® Peak preference: the most preferred display trait value
(the point on the x-axis where the function reaches
maximum value) (Fig. 4a).

® Peak height: the maximum elevation of the function
(on the y-axis) at the preferred stimulus (Fig. 4b).
This trait is a measure of the magnitude of the
response to the preferred value. We have not used it
in prior analyses of variation in mate preferences,
but offer it here for researchers that may be inter-
ested in it.

e Tolerance: the width of the preference function at a
given height (in other words, the range of stimulus
values over which the function remains relatively
high) (Fig. 4c). The height at which we have mea-
sured tolerance in prior work is relative to the height
of the preference function (e.g. the width of the
curve one-third of the way down from the peak),
but it can also be measured at a set absolute height
on the y-axis (see Table 2).

e Preference strength: the degree to which attractiveness
falls away from peak preference as display values
change (in other words, how much the preference
‘punishes’ deviation from the peak) (Fig. 4d). Our
main measure of strength takes into account the over-
all height of the preference function, because any
given amount of drop-off from the peak is relatively
greater for preferences that are lower overall (i.e.
those with lower responsiveness; defined below). We
do, however, offer a height-independent option for
users who want a measure of strength that is indepen-
dent of responsiveness (Fig. 5). In the mate preference
literature, measures akin to our preference strength
have been termed ‘tolerance’, ‘discrimination” or
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‘choosiness’ (Gray & Cade, 1999; McPeek & Gavrilets,
2006; Bailey, 2008; Edward, 2015; Reinhold & Schiel-
zeth, 2015). We prefer ‘strength’ for several reasons.
‘Discrimination’ refers intuitively to the acuity of vari-
ation in sexual response, rather than to its magnitude;
it is thus better suited to questions about the acuity of
perception, as with the framework of just-noticeable
and just-meaningful differences (Kirkpatrick et al.,
2006). And ‘choosiness” has convincingly been applied
to the effort an individual invests in mate assessment,
which may vary independently from the shape of
mate preferences (Jennions & Petrie, 1997). (A related
sense of the term ‘choosiness’ could be the effort
invested in obtaining a preferred mate type.) Other
authors suggest measuring the strength of mate pref-
erences with the slope of the preference function (e.g.
the slope of linear or quadratic functions) (Brooks &
Endler, 2001; Edward, 2015). We favour our measures
of strength because they do not rely on assumed
shapes for the preference function and because they
provide a direct link between the mate preference
function as a hypothesis about the form of sexual
selection due to mate choice and the standard mea-
sure of the strength of selection (Schluter, 1988).

e Responsiveness: the overall elevation of the preference
function (the mean of the y-axis values along the
function curve) (Fig. 4e). In the mate choice litera-
ture, the term ‘responsiveness’ is often used to
denote the motivation to mate, or overall sexual
receptivity (see review by Edward, 2015). In this
sense, responsiveness refers to a variable that is
broader than an aspect of mate preferences
(Jennions & Petrie, 1997; Cotton et al., 2006).

These preference traits are useful for analysing varia-
tion in mate preferences between individuals, experi-
mental treatments, populations, species, and so on (e.g.
Fowler-Finn & Rodriguez, 2012a,b; Rodriguez et al.,
2013b). Characterized for different populations or spe-
cies and contrasted with the distribution of male traits,
the preference traits directly relate to hypotheses about
the action of sexual selection due to mate choice (e.g.
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Fig. 3 Example of how the smoothing parameter influences the shape of mate preference functions generated with cubic splines. Panels
(a—c) go from weaker to stronger smoothing, yielding wobblier to stiffer functions. The function in panel (b) is generated by the default

settings in PFunc and is the same as in Fig. 2b.
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Fig. 4 Mate preference function traits. (a) Peak preference: the
preferred display trait value. (b) Peak height: the maximum
elevation of the function (on the y-axis) at the preferred stimulus.
(c) Tolerance: the width of the preference function at a given
elevation, either relative to the height of the peak or at a set
value. (d) Preference strength: the degree to which attractiveness
falls away from peak preference (see Fig. 5). (e) Responsiveness:
overall elevation of the preference function.

Rodriguez et al., 2006, 2013a). Peak preference (Fig. 4a)
predicts the display trait value that ought to occupy the
peak of fitness functions if selection was mainly due to
mate choice. Preference strength (Fig. 4b) predicts the
degree to which mate preferences may contribute to
overall selection (relative to other potential sources of
selection) (Rodriguez et al., 2006, 2013a). (Note that
the strength of sexual selection will also be influenced
by mating system and mate searching strategies.) Simi-
larly, tolerance and responsiveness (Fig. 4c,e) likely
reflect aspects of the predicted strength of selection.

In our work, we have often found that strength, tol-
erance and responsiveness are correlated with each
other and independent of peak — broad preferences (i.e.
those with high tolerance) tend to be shallower than
narrow preferences, regardless of the position of the

(a) (b)

N
N

Fig. 5 Examples of differences in preference function strength.
Strength is a unitless measure of the vertical range of a spline. We
offer two different measures of strength: one that is height
dependent {calculated as: [SD(response values)/mean(response
values)]?} and one that is height independent {calculated as: [SD
(response values)/(max response — min response)]}. In panel (a),
both curves have higher strength (by both measures) than the
curves in panel (b). Within each panel, both curves have the same
height-independent strength, but different height-dependent
strength (higher curves have lower height-dependent strength).
We recommend using height-dependent strength unless there is
specific reason to use the height-independent measure.

peak (e.g. Fowler-Finn & Rodriguez, 2012a,b, 2013;
Rodriguez et al, 2013b). However, the relationship
between preference traits may vary among species and
experiments, and we allow estimating the preference
traits separately so that researchers may explore how
they relate to each other. For group-level functions,
there may be some additional considerations for analy-
sis. For instance, if data are combined from multiple
individuals, standardization of response scores by
researchers may be necessary (say, standardizing the
maximum response of each individual to a common
value). This of course would take meaning away from
the responsiveness and peak-height measurements.

The program: PFunc

We wrote a computer program called PFunc to describe
and analyse mate preference functions. It was devel-
oped and coded by JTK with input from all authors.
PFunc allows users to instantly visualize preference
functions and several key metrics of the curves. Users
can fine-tune individual functions when necessary and
can output their results into csv files that can be used
for further analysis and graphing in other programs.
The program is built from two main components.
The first is code written in R (R Core Team, 2017) that
handles most of the analysis. It fits curves through data
using the gam function in the mgcv package (Wood,
2006), and it outputs measurements of those curves to
the user. The second component is a graphical user
interface (GUI) (Fig. 6) that is written in Python and
uses the 1py2 package to interface with R (see
Appendix S1 for set-up and usage instructions; see
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Appendix S2 for the program files. The most recent ver-
sion can be downloaded from https://github.com/jocca
lor/ptunc/releases/latest).

Here, we focus on using PFunc with the GUI to make
it accessible to a broad audience. However, for those
comfortable working in the R environment, it is also
possible to run PFunc directly from the R command
line (see Appendix S1).

Getting started with PFunc

Consider an experiment in which females are presented
with a set of playback stimuli — the experiment that
yielded the data in Fig. 2, in which females were
exposed to 19 different stimuli resembling male adver-
tisement signals (in random order) that varied in pitch.
A female’s response was measured as the number of
times she responded positively to these signals over
multiple exposures (with the maximum number being
the number of times a given stimulus was played).

To analyse these data in PFunc, the user first orga-
nizes them in a spreadsheet, following one of the two
layout options described in the data layout section
below, and saves it as a csv file. Once the data are in
this format, the user can open them in PFunc and
begin analysis immediately.

PFunc plots the data points and fits cubic splines to
them. The program displays up to nine graphs per page
at a time, and the user can navigate between pages
with the controls at the bottom of the screen to access
all the graphs. Clicking on a graph brings up its infor-
mation in the control panel on the right-hand side of
the window (Fig. 6), including the smoothing parame-
ter and the trait-by-trait breakdown of the curve. Dou-
ble-clicking on a graph enlarges it for better visibility,
and double-clicking on an enlarged graph returns the
user to the previous view. Users can also view PFunc’s
running message log, which displays certain messages
and warnings from the current session
(Advanced > Show Message Log) (Fig. 6d).

Adjusting the smoothing parameter

The gam function chooses smoothing parameters based
on an algorithm that optimizes the fit of the curve
using generalized cross-validation (Schluter, 1988;
Wood, 2006, 2011). Sometimes, though, the default
smoothing parameter is not ideal for preference func-
tions; it may be so low that it makes the preference
function very wobbly, with many peaks and troughs,
or it may be so high that it makes the function per-
fectly linear. To restrict the likelihood of these extreme
outcomes, and following the philosophy that preference
functions should be neither too wobbly nor too stiff,
we limit the default smoothing parameter to a range of
0.05-5. We have found that this represents a useful
range of natural shapes. However, we have also
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included the option to freely adjust the smoothing
parameter and these limits so that researchers may
explore its effect (Table 2).

The box labelled ‘Smoothing” shows the smoothing
parameter for the currently selected curve (click to
select) (Fig. 6). Users can increase or decrease this
value either by pressing the +/— buttons or by typing in
a new value and pressing the Enter key (user-defined
smoothing parameters are not constrained by the 0.05—
5.0 range). When a smoothing parameter is altered by
the user, an indicator symbol next to the graph changes
in colour from magenta to cyan. This helps the user
keep track of which smoothing parameters have been
altered and which are at their default value. Any time
that a user wishes to revert to the default smoothing
parameter for a particular curve, they select the curve
and press the ‘Reset” button in the Smoothing box. This
will change the indicator symbol back to magenta.

User-defined smoothing parameters persist through
single PFunc sessions and are not automatically saved if
the program is closed. However, users can save their
custom smoothing parameter values from the File
menu (File > Save Smoothing Values...). It is impor-
tant that this saved file remains in the csv format, or
else it may not work in future. Users can also load pre-
viously saved smoothing parameter values from the File
menu (File > Load Smoothing Values...). Note that if
the user makes any changes to the data file between
sessions — specifically, if they add, remove or rearrange
individuals in the data file — the saved smoothing
parameter file may not apply the correct values to the
correct individuals. We always recommend double-
checking to make sure that PFunc is handling the data
correctly. Any changes made to smoothing parameter
values will not be made permanent until the user re-
saves the smoothing parameter file. The user also has
the option of resetting all smoothing parameter values
for the session from the File menu (File > Clear
Smoothing Values).

The power to freely adjust smoothing parameters can
be helptful in a cursory exploration of data, but it is also
dangerous, because it invites temptation to interfere
with otherwise objectively fit curves. Excessive fine-
tuning of smoothing parameters has the potential to
introduce bias into the data that should be avoided at
all costs. In our work with preference functions, we
take a conservative approach to adjusting smoothing
parameters. We first establish our minimum and maxi-
mum smoothing values, and then we almost always
keep the default smoothing values that are calculated.
The few times that we have adjusted smoothing param-
eters for published data were instances where we saw
clear trends in the data that were not reflected in the
curve, and we made these changes without knowledge
of the identities of those individuals nor the groups
they belonged to. We urge all users to take a similarly
conservative  approach to adjusting smoothing

© 2017 EUROPEAN SOCIETY FOR EVOLUTIONARY BIOLOGY. J. EVOL. BIOL. 30 (2017) 1658-1673
JOURNAL OF EVOLUTIONARY BIOLOGY © 2017 EUROPEAN SOCIETY FOR EVOLUTIONARY BIOLOGY


https://github.com/joccalor/pfunc/releases/latest
https://github.com/joccalor/pfunc/releases/latest

1664 J. T. KILMER ET AL.

(a)

(b)

PFunc s distibuted urbes the GNU Geveral Pulbli License v3. See Aboul in the Hel menu for
basne, e .

& =

()

14 PFunc
File Adwanced Help

Select the individuals to be used
in this group-level spline.

Click and drag to select multiple
individuals al unce. Hold down
ctrlto add or subtract individuals
from your selection.

Name [spline8

Smoothing
02510248 | <] eeset

[Peak Preference: 137,156

Peak Heighl: 2 116
Tolerance: 25372
Strength: 0,367
Responsiveness: 1.263
Smoothing: 02510248

—settings—

¥ Peak &Tolerance
¥ Splines

™ standaraemor
’rmmn;unﬁp

Min[005  Max[S

Find Local Peak [

{ Between[130 ana230

& Droptrom peak I/F
Maord

€ tselvalue[T

Mode @ Droad © Strict

strength
{M

7+ PRunc — n 1%
File Advanced Help @ PFunc
gascihng File Advanced Hel
-l - sl p
v Open Data File

[Pear preterence:

Peak Height:

EE':.'.','-':._T Load Smoothing Values... |_

fponsiveness
5"““""‘:“ Save Smoothing Values...
as--

View Clear Smoothing Values

I hames

¥ Data Paints = =

Welcome to PFunc 7=t Load Previous Settings
i FE| sphnes Save Current Settings
Open a data file ta hegin I~ stanaara eror N

‘Smoothing Umts 7 Restore Default Settings
Min[005  Maxl5 . )

Find Locol Peak [~ Output Spline Figures...

( Between|min’ ang|max Output Spline Summaries...
& oroptrompeakiFs Output Spline Points...

- m"m:',‘,ir OQutput Tolerance Points... 3 l I I e to P [ u
Mode & Bioad  Stid N

[T g— CQuit

pen a data file to begin.

(d)

@ PFunc Mess... —

18:07 Welcome to PFunc. Open a
data file to begin. See
the Help menu or the
RERDME file for help.

158:07 Opened a new file.

© 2017 EUROPEAN SOCIETY FOR EVOLUTIONARY BIOLOGY. J. EVOL. BIOL. 30 (2017) 1658-1673
JOURNAL OF EVOLUTIONARY BIOLOGY © 2017 EUROPEAN SOCIETY FOR EVOLUTIONARY BIOLOGY



Describing mate preference functions 1665

Fig. 6 Screenshots of PFunc’s graphical user interface. (a) The starting interface. (b) Opening a data file. (c) Analysing multiple preference
functions. (d) The message log (accessible from Advanced > Show Message Log). (e) Creating a group-level spline (accessible from
Advanced > Construct Group-Level Spline...). (f) Visualization of a group-level spline.

parameters. To help with this, PFunc’s default settings
display preference functions without the names of the
individuals associated with those splines. If the user
wishes to view the names, they may toggle them from
the View box in the sidebar.

Data layout

PFunc allows data to be formatted in either of two
ways: horizontally or vertically. In the horizontal
arrangement, the first column of the spreadsheet con-
tains the stimulus values (in our treehopper example,
those would be the signal frequencies of male calls
that the females are exposed to). Then, each subse-
quent column contains the responses of a different
individual to the stimuli in column 1 (Table 1a). By
comparison, the vertical arrangement contains at least
three columns: one for individual IDs, one for the
stimulus values, and one for the individual responses
(Table 1b). When choosing the vertical option, users
will be prompted to tell PFunc which columns of their
data correspond to each of the three types of informa-
tion (individual identity, stimulus value and response
score). Both data layout options work equally well,
and we leave it to the user to decide which configura-
tion works best for them. In the horizontal arrange-
ment, new individuals are added with additional
columns, whereas in the vertical arrangement, they
are added with additional rows. Note that the vertical
option gives users more flexibility when it comes to

testing different individuals against different sets of sti-
mulus values, because these values are specified for
each individual, rather than once for the whole data-
set.

For either arrangement, there must be at least three
(preferably ten or more) responses per individual (or
whatever the experimental unit is). Additionally, for
typical studies, we recommend having no more than
one response value per stimulus value per individual. If
there are multiple responses per stimulus per individ-
ual, researchers should consider consolidating them
into a single measure (e.g. an individual’s mean
response to each stimulus) or splitting the individual’s
data up by trial, depending on what the structure of
the data allows for. This is to avoid pseudoreplication,
but note that researchers can still asses the repeatability
(see Boake, 1989) of individual responses and/or pref-
erence function metrics, but would do so externally to
the program (e.g. with the preference function traits
generated by the program; Fowler-Finn & Rodriguez,
2013).

Group-level preference functions

Researchers may wish to go beyond individual-level
splines and examine group-level splines, for example,
at the replicate, population or species level. Addition-
ally, group-level functions may also be useful for study-
ing organisms for which it is not possible to test
individuals repeatedly with a range of stimuli.

Table 1 Options for arranging data for PFunc. (a) The horizontal option: stimulus values are listed in the first column, and each
subsequent column contains the responses of a different individual to those stimuli (in this case, the number of times each female
responded to each stimulus value). (b) The vertical option: there are at least three columns, each containing a different type of
information: individual identity, stimulus values and the responses of individuals to each of the stimulus values. (Note that the use of four
stimulus values per individual here is purely for the sake of example. Although it is possible to use only four values in real studies, we

recommend using more.)

(@) horizontal option

(b) vertical option

Stimulus (Hz) Female_1 Female_2 Female_3 Individual Stimulus (Hz) Response
180 1 1 0 Female_1 180 1
190 2 3 2 Female_1 190 2
200 3 3 4 Female_1 200 3
210 0 1 4 Female_1 210 0
Female_2 180 1
Female_2 190 3
Female_2 200 3
Female_2 210 1
Female_3 180 0
Female_3 190 2
Female_3 200 4
Female_3 210 4
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Table 2 Explanations of settings options from the PFunc control panel.

Category

Setting

Details

Default

View

Smoothing Limits

Find Local Peak

Tolerance

Strength

Names
Data Points

Peak & Tolerance

Splines
Standard Error

On/off

Min

On/off

Min
Max
Options

Drop from peak

Floor

At set value

Mode

Height Dependence

Toggles the display of names above each graph.

Toggles the display of raw data points on each graph. If the user is working
with group-level splines, this option also controls the view of the individual-
level splines that make up the group spline.

Toggles the display of red and blue lines marking peak and tolerance
(respectively) on the graphs.

Toggles the display of splines (preference functions) on the graphs.

Toggles the display of dashed lines on either side of the spline, representing
the range of +1 standard error, as calculated by the gam function. This
standard error is a measure of how well the spline fits the data, not a
measure of the spread of the data.

Smoothing Limits restricts the default smoothing parameter to a certain range.
This is useful for avoiding splines that are either too wobbly or too stiff, but
the user has the option of toggling it off.

Sets the minimum value for default smoothing parameters (but the user can
manually adjust the smoothing parameter beyond this limit).

Like min, but for the maximum value.

Gives users the option to focus on specific regions of the splines that contain
secondary peaks of interest (e.g. the lower left-hand corner of Fig. 6c).
PFunc first searches for a peak between the min and max values (below). If it
finds a peak, then it uses it. If not, then it expands its search across the
entire spline.

Sets the lower boundary for the search for local peaks.

Sets the upper boundary for the search for local peaks.

There are two options for measuring tolerance: relative or absolute.

® In the relative option, tolerance is the width of the curve at a cer-

tain proportion down from the peak. To select the relative option,
click the radio button next to ‘Drop from peak’.

® In the absolute option, tolerance is measured at a specified y-value,

regardless of the height of the peak. To select the absolute option,
click the radio button next to ‘At set value’.

Used for calculating relative tolerance. Controls how far down on the spline
that PFunc measures tolerance (the width of the curve). Drop is expressed
as a proportion of the distance from the peak of the spline to the floor (see
below). It can be written as either a decimal or a fraction.

Used for calculating relative tolerance. Adjusts the height of the baseline from
which tolerance is measured. In calculating tolerance, the floor is the lower
limit, whereas the peak height of the curve is the upper limit, and tolerance is
measured as a proportion of the distance between the two.

Used for calculating absolute tolerance. This value defines the point on the y-
axis at which tolerance for all splines is measured.

Controls how PFunc handles cases where there are multiple peaks along the
spline that are above the tolerance line (e.g. the lower left-hand corner of
Fig. 6¢). If mode is set to Broad, then tolerance is the sum of all the
tolerance segments across the range of stimulus values. If mode is set to
Strict, tolerance is only the width of the curve under the highest peak.

Controls whether strength depends on the height of the spline (i.e.
responsiveness) (Fig. 5)

0.05

5.0
Off

Relative

1/3

Broad

Height dependent

To do this, users select Construct Group-Level Spline
from the Advanced menu, and a window pops up list-
ing all of the individuals in the data set (Fig. 6e). In
this window, users can name their new group spline
and select the individuals that they want to include in
it (select multiple individuals by clicking and dragging
or by holding down the Ctrl key while making the

and fits a spline through them.

selection). PFunc uses the chosen splines as new input
data to fit a single group-level spline; that is, it converts
the individual curves into many closely-spaced points,

The new group-level spline is added to the end of the

working data set and displayed alongside the individ-
ual-level splines (Fig. 6f). Note that this does not alter
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the original data file. The new graph displays the
group-level spline as well as the individual splines that
are part of the group. The visibility of the individual
splines can be toggled with the Data Points checkbox
under the View options (Table 2). Group-level splines
behave just as individual splines do, and all of the set-
tings and output options that apply to individuals also
apply to groups.

We recommend using lower smoothing parameters
for group splines than for individual splines. As group-
level splines are themselves based on smooth curves,
they tend to be relatively smooth to begin with, even
with very small values for the smoothing parameter.
Restricting group smoothing parameters to the same
range as individual splines may result in overly stiff
group-level curves.

Changing settings

We have chosen the default settings that we think,
based on our experience, will work best across a
broad range of experimental set-ups. However, we
include a variety of options in PFunc for the user to
adjust according to their needs. Settings can be
adjusted from the control panel on the right-hand
side of the screen (see Table 2 for details). Users can
save the settings configuration of their current session
for future use from the File menu (File > Save Cur-
rent Settings). Users can restore saved settings from a
previous session (File > Load Previous Settings), or
they can revert to the default settings (File > Restore
Default Settings).

Saving and exporting the analyses

PFunc comes with several options for exporting data:
(i) the user can export a pdf of all the preference
function graphs drawn from the data file (File > Out-
put Spline Figures...). (ii) The user can export a
spreadsheet displaying the five preference traits plus
the smoothing values for all the curves of every indi-
vidual in the data set (File > Output Spline Sum-
maries...). (iii) The user can export a spreadsheet
containing values of points that make up the curves
of the preference functions for all individuals
(File > Output Spline Points...). This option is useful
for those who wish to plot the splines in a separate
program to make figures for publications. It is also
useful for those who want to save group-level splines.
(iv) The user can export a spreadsheet containing the
tolerance points for all individuals (File > Output Tol-
erance Points...). Tolerance points are the x-values
that correspond to the boundaries of where tolerance
is measured. This can be useful for plotting preference
functions in other programs or for studies where these
values are points of interest.

Describing mate preference functions 1667

Discussion

We have presented a simple and efficient method for
analysing mate preference functions, and a program
that implements it on many individuals at a time. We
now comment on some decisions that researchers have
to make for the purpose of conducting the experiments
that generate the data that can be used with our
method.

The assay of attractiveness

Any method for describing mate preferences is only as
good as the assay of attractiveness on which it is based.
The decision of which assay to use should be based on
the biology and behaviour of the study species (Reinhold
& Schielzeth, 2015). A good assay consists of a specialized
behaviour or response performed only in the context of
mate acceptance, so that there is minimal risk of count-
ing incidental or spurious responses. A classic example of
an assay used in studies of mate preference is the phono-
taxis behaviour involved in pair formation in many anu-
rans and orthopterans, whereby females approach
signalling males or playback stimuli that resemble sig-
nalling males (Gerhardt & Huber, 2002; Greenfield,
2002). In species where pair formation involves male—
female signal exchanges (duetting), a simple and biologi-
cally relevant assay is whether females reply with their
own signals to males or to playback stimuli (e.g. Parri
et al.,, 2002; Rodriguez et al., 2004; Derlink et al., 2014;
Reichert & Ronacher, 2015). Other species may engage
in other types of back-and-forth interaction between the
sexes that present cues of likely mate acceptance (e.g.
the adoption of a solicitation posture; Patricelli et al.,
2002, 2006). Such interactions may offer useful assays
for studies of mate preferences, and are drastically under-
studied (Rodriguez, 2015).

When it comes to quantifying acceptance behaviour,
there are several options for what the response variable
could be. (i) It could be the number of times an indi-
vidual responds to each stimulus value (expressed
either as a raw count or as a proportion of total expo-
sures to each stimulus). (ii) In the case of choice trials
(discussed below), it could be the proportion of times
one stimulus was preferred over another. (iii) It could
be based on the latency to mate acceptance. (iv) It
could be some other score of acceptance. Note that
even if the structure of the data would be described as
binomial (e.g. with only 1 and 0 for response/no
response) or as Poisson (e.g. with only a possibility of
0, 1, 2 or 3 responses from an individual tested three
times per stimulus), the spline that PFunc fits will be in
the Gaussian family. The goal is to capture the smooth
function (the cognitive phenotype) that underlies the
behaviour, rather than reflect the particularities of the
experimental assay.
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We offer a note of caution about assays based on
realized mate choice decisions (e.g. whether a mating
occurs or not). Such assays may have restricted useful-
ness in the study of mate preferences. One reason for
this is that preferences and decisions are different cog-
nitive phenotypes (Cotton et al, 2006; Mendelson
et al., 2016): preferences influence decisions, but are
distinct from them. Another reason is that whether
mating occurs or not is the outcome of male—female
interactions that are influenced by more variables than
the preference of one individual. A mate choice deci-
sion represents not only whether a female found a
male attractive but also whether he found her attrac-
tive, for how long and with what intensity he courted
her, the presence and distribution of other potential
mates and so on. In other words, a realized mate
choice decision arises from the expression of a mate
preference but is also influenced by multiple inputs
from the social context in which it is expressed. Addi-
tionally, individuals may accept a mate whose features
are not the most preferred (not at the peak of the pref-
erence) but fall within an acceptable range, which con-
founds mate preference functions with other factors
that influence mate choice decisions, such as mate
sampling strategies, choosiness and absolute versus rel-
ative criteria for mate acceptance (Jennions & Petrie,
1997; Widemo & Seaether, 1999; Brandt ef al., 2005;
Cotton et al., 2006).

Having said the above, we acknowledge that assays
based on realized mate choice decisions may be the
only suitable option for some species. For example, it
may only be logistically feasible or ethically permissi-
ble to study some species in the field. Other species
may not respond well to artificial stimuli, may not
produce an obvious mate-acceptance response or may
not thrive in laboratory settings. In such cases,
researchers may only be able to observe realized deci-
sions such as nesting pairings. One solution to the
above limitation may be to observe multiple decisions
for each individual, each with different potential
mates, in order to isolate the contribution of that indi-
vidual’s preferences to the outcome of interactions
with the different males.

What we wish to emphasize is that the assay of sex-
ual response should pinpoint as much as possible the
mate preference as an individual’s trait, and distinguish
it as much as possible from variation due to inputs
other than the features of the stimuli or males that the
individual is responding to. With this consideration in
mind, we would argue against conceptualizing the
assay of attractiveness as a measure of the resources
invested in reproduction with a mate (cf. Edward,
2015). The resources invested in reproduction reflect
choosiness, realized mate choice decisions and decisions
made after mate choice (Jennions & Petrie, 1997)
rather than the cognitive phenotypes that influence
those decisions.

The range of variation in the display trait over which
to assess mate preferences

Characterizing mate preferences requires assaying
attractiveness over an appropriate range of variation in
sexual traits. To capture the full shape of the prefer-
ence, we recommend that stimuli should not only span
the natural range of variation in the trait, but exceed it
somewhat. This is because assessing the attractiveness
of phenotypes beyond the population range provides a
more complete description of the selective landscape as
determined by mate preferences (cf. Schluter, 1988).
Too narrow a range may underestimate the amount of
variation in the attractiveness of displays — it may not
capture the full shape of the preference, which might
yield misleading expectations about the form of sexual
selection due to mate choice. On the other hand, an
excessively broad range may detract from biological
interpretability, although even then it might reveal hid-
den preferences or supernormal responses (Arak &
Enquist, 1993; Gray et al., 2016). This is a decision that
researchers have to make according to the biology of
their study species and the scope of their research ques-
tions.

Additionally, researchers will have to decide on an
appropriate number of stimuli to test. The use of more
stimuli (more stimulus values) increases the resolution
of the splines, but it also means more trials for each
individual, which can lead to fatigue or habituation.
Therefore, one must strike a balance between the reso-
lution of their preference functions and the tolerance of
individual animals to repeated testing. We recommend
using at least 10 different stimuli. Although PFunc can
handle data with fewer than 10 stimulus values, the
resolution of the preference functions may be reduced,
and users may find the need to relax the limits on
smoothing parameters.

A related consideration is the distribution of stimulus
values along the range to be tested. Stimuli may be
spread evenly along the range (say, from 100 to 200 Hz
in steps of 10 Hz) (e.g. Rodriguez et al., 2006), or they
may cover some parts of the range more densely than
others (say, finer steps near the suspected peak in order
to pinpoint it more precisely) (e.g. Fowler-Finn &
Rodriguez, 2012a,b).

Researchers should also consider how best to handle
a data set that has missing values. In general, function-
valued approaches have the advantage of being robust
to missing data (Stinchcombe et al., 2012). However,
we consider that the ideal situation is one in which
each individual is tested on every single stimulus value
(recognizing that the reality of behavioural research
with live animals may make this difficult to achieve).
Individuals missing many data points should probably
be excluded from the analysis entirely. Individuals
missing only a few data points may or may not have an
impact on the final analysis, depending on where those
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Fig. 7 Missing data points can have either a small effect (a, b) or a large effect (¢, d) on the interpretation of splines. (a) A spline fit
through a hypothetical data set with a single missing value in the middle of the range (represented by the grey box). The arrow indicates
the peak. (b) The same data set with the highest possible and the lowest possible values filled in for the missing data point (open circles).
Splines fit through the two possible extremes have the same general shape, and the peak varies by < 5% of the range in either direction
compared to the peak in (a). Meanwhile, (c) shows a spline fit through data that is missing the response to the highest stimulus. This
preference function appears to be open-ended, but if it is compared with other individuals in the same experiment, its peak comes out to
be 190 instead of the extreme value of 200, which other open-ended preferences will have. Furthermore, this missing value holds more
weight in determining the shape of the spline (d). The spline could end up being either open-ended or closed, and the peak varies by 10%
or more of the range in either direction compared to the peak in (c).

points lie. I an individual is missing data in the middle
of the test range, other points surrounding the missing
value inform the shape of the curve (Fig. 7a,b). But a
missing data point on the edge of the test range may
lead to misinterpretation of the results, especially for
preference functions that appear to be open-ended
(Fig. 7¢,d).

Design of mate preference experiments: choice and
no-choice trials

A wide variety of methods are available for conducting
playback experiments. So-called choice trials present
individuals with two or more options or stimuli, and
assemble a series of such trials to construct an overall
preference function across stimulus pairs (e.g. Jang &
Greenfield, 1996; Gerhardt et al,, 2000). Other methods
use series of such choice trials to generate attractiveness
scores for individual stimuli, and then use a set of those

scores to construct the preference function (e.g. Ritchie,
1996; Simmons et al., 2001; Brooks et al., 2005). On the
other hand, so-called no-choice trials (also termed sin-
gle-stimulus trials) present one stimulus at a time and
measure the response to each stimulus (e.g. Fig. 2;
Rodriguez et al., 2006).

There is reason to think that choice and no-choice
designs may require different interpretation. In choice
trials, the response to one stimulus depends on the rel-
ative attractiveness of the other stimulus in the pair,
and this may influence the outcome of trials. Addition-
ally, choice trials reflect not only mate preferences but
also variation in investment in sampling (Wagner,
1998; Beckers & Wagner, 2011). These confounding
factors may make it harder to capture the true shape of
the mate preference with choice designs, making no-
choice designs often preferable. (On the flip side, the
sequence of stimuli in no-choice designs may influence
their relative attractiveness, and sequences should be
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randomized.) There is evidence, however, that well-
designed choice and no-choice experiments reach simi-
lar conclusions (Bush et al.,, 2002), although they may
vary in the strength of the mate preferences that they
estimate (Dougherty & Shuker, 2015).

On significance testing

Here, we have focused on generating preference func-
tions, visualizing them and extracting metrics to charac-
terize them. One component of data analysis that our
program leaves out is significance testing. For instance,
to compare the mate preferences for a given signal trait
between two species, PFunc will plot them and analyse
them in terms of the preference traits described above.
Each of the traits can then be compared between the
two species with simple tests using commonly available
statistical programs (e.g. one-way aAnNova to test for a
species difference in peak preference, with a sample of
individuals for each species). However, one may also
want significance tests for a difference in the overall
preference functions of the two species. For this pur-
pose, some researchers have used statistical models
with linear and quadratic terms for the stimulus fea-
tures, in combination with visualization using nonpara-
metric regression (such as with cubic splines) (e.g.
Brooks & Endler, 2001; Brooks et al., 2005; Bentsen
et al., 2006; Rodriguez et al., 2006; Bailey, 2008; Ger-
hardt & Brooks, 2009). We have found this combina-
tion of approaches to be useful. For the above species
comparison of the preferences of two species, the statis-
tical model could include the following terms: a term
for species, linear and quadratic terms for the values of
the stimuli, and interactions between the species term
and the linear and quadratic stimulus frequency terms
(e.g. Rodriguez et al., 2006). The species x linear term
would test for differences in the linear components of
the preferences, and the species x quadratic term
would test for differences in the curvilinear compo-
nents. Similar models can be used to compare prefer-
ences not only between species but also between
treatments (e.g. Fowler-Finn & Rodriguez, 2012a,b).
(Note that when each individual contributes a prefer-
ence function to the analysis — when each individual
was tested multiple times with different stimuli — indi-
vidual ID should be included as a random factor in the
statistical model to avoid pseudoreplication).

Univariate and multivariate mate preference
functions

The method we present here is based on the manipula-
tion of only one stimulus variable at a time, rather than
multiple stimulus variables. We recognize that percep-
tion and selection often involve multiple aspects of dis-
play phenotypes, and there are methods of analysis
available to explore attractiveness and fitness surfaces

(e.g. Brodie ef al., 1995; Brooks et al., 2005; Bentsen
et al., 2006; Ower et al., 2013; Hennig et al., 2016). In
some cases, however, the univariate approach may be
most appropriate for how the study organism processes
stimuli. For example, females of some cricket species
process male signal pulse rate as a single (effectively
univariate) trait, despite the fact that pulse rate is in
fact a compound trait determined by both pulse dura-
tion and interpulse duration (Hennig et al., 2014; Blan-
kers et al, 2015). Another reason the univariate
approach is broadly useful is that different display traits
are often associated with mate preferences of different
shapes, so that analysing display—preference relation-
ships on a trait-by-trait basis enhances the explanatory
power of tests of the contribution of mate preferences
to sexual selection and display divergence (Rodriguez
et al., 2006, 2013a).

Broader applicability of the method

Nonbehavioural mate preferences

In this paper, we have focused on mate preferences as
cognitive phenotypes (Mendelson ef al,, 2016). How-
ever, there are many other types of sexual response
that can be studied using the method that we outline
here. Indeed, any response of interest may be used as
the y-axis to characterize the causes of mate choice at
any stage of the reproductive process.

As above, our main suggestion would be to use
assays of sexual response that approach as closely as
possible the focal individual’s trait without influence
from the interaction with mating partners. For exam-
ple, we would consider whether females are induced to
expel previously stored sperm by genitalic stimuli (von
Helversen & von Helversen, 1991) to be a better assay
than those same females” fertilization patterns, because
the former better approximates the female function-
valued trait of interest. Having said that, we recognize
that this goal may be challenging for studies of mate
preferences at stages of the reproductive process subse-
quent to pair formation, such as studies of cryptic mate
choice — it may sometimes be impossible to avoid using
interacting individuals in mate preference trials. In such
cases, observing interactions of each female with a sam-
ple of males may help characterize her preferences (e.g.
Sirot et al., 2007).

Other function-valued traits

Our method is also applicable to any function-valued
trait, regardless of whether it involves mate prefer-
ences or behaviour. For instance, it could be used to
study variation in developmental trajectories or in
plasticity across a range of environmental conditions,
as long as the x-axis variable is continuous (Izem &
Kingsolver, 2005; Kingsolver & Gomulkiewicz, 2003;
Meyer & Kirkpatrick, 2005; Stinchcombe ef al.,, 2012;
Murren et al, 2014; XKingsolver et al, 2015). We
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suggest that the main consideration in deciding
whether to use our method should be whether
researchers desire to make assumptions about the
shape of the functions of interest. We hope that this
approach will be broadly useful.
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